Simulation-Based Impact
Analysis Handbook
Okan Team
More information can also be found in D1.4 Mapping & Impact Assessement Report,
eg. simulation-based assessments of the environmental impact and passenger
transport effectiveness performed on two mobility use-cases: 32. Intelligent BRT
(Istanbul, TR) and 6. SOftly MObile Tourism Mobility (Alpine Pearls/Werfenweng, AT)
--
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1. Data Requirement
The transportation model requires some data to be set up and run in a microsimulation. In this way, simulation
outputs can provide realistic results.
For unavailable information, assumptions to reflect “normal/ordinary/customary” situations will be made,
reducing simulation realism.
For simulation of specific use-cases, further data may be necessary. Below, the list of data expected to be
sufficient for most use-cases is listed.

1.1. Location and Boundary of the Working Area
The geographical location of the study area and the precise boundaries of the study area should be determined.

1.2. Road Geometry (lengths, lanes, curvature)





Number of lanes
Lane length
Free-flow speed
Lane width

For intersections:
 Right and Left turn lanes
 Their vehicle storage lengths.
If detailed data is not available in this category, intermediary programs such as Google Earth or aerial
photographs may/will be used when creating a model.

1.3. Control Data
 Locations of traffic control devices
 Signal-timing settings (green, yellow and red times within each cycle time)

1.4. Vehicle Characteristics
The characteristics of all vehicles in the current situation and planned to include in the transportation system
should be detailed.
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 The brand and model of an existing car; e.g. 20 Renault ZOE, 25 Nissan van Elgrand, 42 Smart Fortwo
 Also, the length of the vehicle, maximum speed, maximum acceleration, and maximum deceleration
values should be defined; e.g. Bus: Length:40 ft, Maximum Speed 65mi/h, Maximum Acceleration: 5 ft/s2,
Maximum Deceleration: 15 ft/s2. Number of Buses: 120
 Type of fuel used (gasoline, octane rating, diesel fuel grades, etc.)
 For e-vehicles, vehicle mass (kg), power (kW), battery capacity (kWh), motor and battery type, and
certified energy consumption (kWh/100 km).

1.5. Traffic Demand
 The traffic demand between the zones in the region must be specified. For this, it is necessary to create
an Origin-Destination matrix or specify how the trips are distributed among the zones.
 Existing and planned public transport routes and vehicles operating on these lines
 The number of passengers coming to the region and the vehicles they use
 Number of vehicles using the region for transit
 Does traffic demand change seasonally or periodically?
 If a traffic count has been made in the working area, it is useful.
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2. Modeling Simulations
To obtain realistic results from simulation programs that are frequently used in transportation planning and
policies, the existing traffic model should be prepared in detail with many different parameters.
In the previous section, the required data for constructing a simulation model are listed. This section describes
how we model and evaluate transportation with PTV VISSIM.

2.1. Building the model
For the simulation setup to give real-world and accurate results, all parameters must be added in accordance
with real-world data. In the calibration step, the road/intersection is drawn exactly as it is in reality.
The characteristics of the traffic flow can vary from country to country, from city to city, and even from region to
region. To model this variation precisely, data on the traffic characteristics of the area are needed. Adding many
specific characteristics such as lane change behavior, driver behavior, lateral behavior, vehicle following
behavior, and acceleration/deceleration values to the simulation will ensure that the outputs give the most
realistic results.
After making sure that the simulation is built in the closest way to the real world, if there is traffic counting from
this area, it is possible to compare the outputs by placing the point counting tools in the same location.



After the software is opened, to specify the file name and location where the file will be saved,
“File>Save as” must be done after the software is opened.
Before modeling the simulation, the parameters should be determined in detail. The simulation period,
start time, and date, simulation resolution must be defined. The simulation resolution has an impact on
the behavior of vehicles, pedestrians, and the way they interact. This is why simulations, using different
simulation resolutions, produce different results. Higher resolutions yield more realistic results but may
increase the simulation runtime (Simulation>Parameters). Before setting up the simulation, the units
used, pedestrian behavior, and traffic regulations should be adjusted. (Base data>Network setting)

2.1.1. BACKGROUND AND MAP
 If the simulation is to be modeled at a specified location, a map provider or background image is used.
Thus, links can be drawn on the world map/image. (Globe symbol> edit basic graphic parameters OR
background images)
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2.1.2. LINKS AND CONNECTIONS
After the simulation parameters and background are set, drawing can be started. Links tool can be used for
this.

 Parameters such as the number of lanes, lane widths, blocked vehicles, blocked right/left turns, road
type, behavior type, z-offset, thickness, and gradient can be changed from the dialog window.
 The geometric form of the road can be made realistic with splines that can be added in the middle of
the road. By making the road drawing transparent, its compatibility with the image below can also be
checked (ctrl+A).

 Road routes in each direction can be drawn in this way. These links are then merged. The geometric
properties of the connectors are adjusted from the dialog window that opens during the merging, and the
appropriate form is given with splines. From the dialog window that opens, settings such as which lane
the roads will merge, lane widths, number of lanes, directions, and restrictions are made.
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 The areas where the traffic flows (according to the drawing) will overlap with each other can be
observed with the Conflict area tool.
 If slowdown is required in certain parts of the road sections, it can be drawn with the Reduced Speed
Area tool.
 Prioritizing the flow of any traffic flow can be adjusted with the Priority Rules tool.
 The stop signs used to prioritize the flow coming from different directions on the road sections are
determined by the Stop Signs tool.
 Ground markings such as pedestrian crossings and arrows can be drawn with Pavement Markings.
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2.1.3. DEFINING 2D/3D MODELS, VEHICLE TYPE, VEHICLE CLASSES
 Vehicles need to be defined to model the current or planned traffic flow. For this, you can choose from
existing 2D/3D models as well as load different models. (Base Data>2D/3D Models>3D
Models>Vehicles>Road) The vehicle length and width can be changed at this step.



Then the defined vehicle type must be added to the vehicle distribution (Distributions>2D/3D model and
Base data>Vehicle type). The previously defined vehicle type is added.

There are two different methods for calculating emission values in PTV VISSIM software. The first of these is
done by entering an external emission model while defining the vehicle type, and the second is done with the
Enviver Pro plugin. Although the emission model cannot be changed directly in the VISSIM software, these
calculations can be made with the external emission models to be defined for the vehicle types.


From the EmissionModel.DLL API downloaded from http://cgi.ptvgroup.com/visionSetups/en/, the
EmissionModel.vcxproj file is opened with Microsoft Visual Studio.
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 EmissionModelExecuteCommand (EMISSION_COMMAND_CREATE_VEHICLE) is called from Vissim
during the simulation run whenever a new vehicle is set into the network in Vissim (at the start of a time
step, from a vehicle input, a PT line or a parking lot). In the same time step, a command
CALCULATE_VEHICLE for the same vehicle will follow later.
 Before this call, some information about the new vehicle is passed to the DLL through calls of
DriverModelSetValue () (shortened “Set” below). The sequence of calls to the DLL is as follows:
 Set EMISSION_DATA_VEH_ID = NumberOfNewVehicle
 Set EMISSION_DATA_VEH_TYPE = VehicleTypeNumber
 Execute EMISSION_COMMAND_CREATE_VEHICLE
EmissionModelExecuteCommand (EMISSION_COMMAND_CALCULATE_VEHICLE) is called from
Vissim during the simulation run once per stime step for each vehicle of a vehicle type which uses this
EmissionModel DLL. Before this call, there are several calls of EmissionModelSetValue () (shortened
“Set” below) to pass the current state of the vehicle to the DLL. After the execution of the command, there
are several calls of EmissionModelGetValue() (shortened “Get” below) to retrieve the calculated emission
values from the DLL.
The sequence of calls to the DLL is as follows:













Set EMISSION_DATA_TIMESTEP = time step length [simulation seconds] [0.05 .. 1.0]
Set EMISSION_DATA_TIME = current simulation time (simulation seconds since simulation start)
Set EMISSION_DATA_TIME_OF_DAY = current simulation time (string format “HH:MM:SS”)
Set EMISSION_DATA_VEH_ID = ID of the vehicle to be calculated
Set EMISSION_DATA_VEH_TYPE = vehicle type number (user defined)
Set EMISSION_DATA_VEH_VELOCITY = current speed [m/s]
Set EMISSION_DATA_VEH_ACCELERATION = current acceleration [m/s²]
Set EMISSION_DATA_VEH_WEIGHT = vehicle weight [kg]
Set EMISSION_DATA_SLOPE = current gradient [radians], downhill = negative
Set EMISSION_DATA_LINK_TYPE = current link behavior type number
Execute EMISSION_COMMAND_CALCULATE_VEHICLE
Get EMISSION_DATA_BENZ = benzene emissions [g/s] in the current time step
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Get EMISSION_DATA_CO = carbon monoxide emissions [g/s] in the current time step
… (many more Get calls for all defined pollutants) …
Get EMISSION_DATA_NAPHT_GAS = naphtalene gas emissions [g/s] in the current time step
The DLL can return 0 to any of the Get calls in order to indicate that it doesn’t provide a value for this
pollutant. In this case, no value is shown in Vissim either.

EmissionModelExecuteCommand (EMISSION_COMMAND_KILL_VEHICLE) is called from Vissim when
a vehicle reaches its destination parking lot (abstract parking lot or zone connector) or leaves the network
(so memory which the DLL might have allocated for that vehicle can be freed). This happens after all calls
of CALCULATE_VEHICLE (including that call for that vehicle in the same time step).
 Set EMISSION_DATA_VEH_ID = ID of the vehicle to be killed
 Set EMISSION_DATA_VEH_TYPE = VehicleTypeNumber
 Execute EMISSION_COMMAND_KILL_DRIVER
The saved project is added to the defined vehicle type as an external model. (Vehicle Type>Special>External
Emission Model.)

2.1.4. INPUT, ROUTES
 The vehicle Routes tool is used to determine the routes of the vehicles. The start and end of the route
are determined.

 Similarly, routes are determined for public transport. The stops on the route are also marked. Stopping
times and passenger capacities of vehicles at stops can also be adjusted.
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It is necessary to determine how much of the traffic volume will enter the network from which link.
Thus, the traffic volume added to the network is distributed according to the routes when the
simulation is run (List>Private transport/Public transport).

2.1.5. DATA COLLECTION AND COUNTERS
 PTV VISSIM allows the collection of detailed data for links, specific points, and sections as well as general
data obtained as a result of simulation. For these operations, nodes, data collection points, vehicle travel
times, queue counters, and sections can be used. Detailed settings can be made from the dialog window
that opens.
 Thanks to these counting tools, points, and sectional counters information can be obtained apart from
general network.
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A vehicle travel time measurement consists of a From Section and a To Section. The mean travel time
from traversing the From Section up to the traversing of the To Section is calculated, including the
waiting time and/or stop time on all lanes.

2.2. Running The Simulation
In the last step, after the file is saved, the simulation is run.
 The simulation can be tested before running if desired. If it gives an error at this stage, it can be corrected
by opening the error file and seeing what the problem is.
 The simulation is run for the specified time interval. however, this time varies according to the
performance of the computer and simulation parameters.

2.3. Simulation Results


The results obtained as a result of the simulation run are given as a list. Some or all of this list can be
copied and pasted into different programs (eg EXCEL) (Evaluation > result list)
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 The simulation results can be obtained for the network, for a specific link, or with counting points.
 Result outputs can be obtained graphically as well as numerical data. This can make it easier to compare
different scenarios and different parameters.

2.4. Scenario Management
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Values for the desired results can be found by using different parameters in the simulation software.
For this, scenarios are set up and it is evaluated that the results can change with each variable
parameter (File>Scenario management> place under scenario management).
Different road geometries, different traffic volumes, or movements can be set in each prepared scenario.
Different scenarios can be created by changing parameters such as all geometric arrangements, traffic
demand, routes, vehicle types, and the number of passengers. In this way, the most effective traffic
flow can be found.

By changing the simulation parameters, it can be determined how the current traffic will be adjusted in
the best / most environmentally friendly way.
For example, in the current scenario, when only the left turn rates are reduced from 50% to 20%, the
emission values decrease due to the more stable movement of the traffic flow.
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RECIPROCITY (Replication of innovative concepts for peri-urban, rural or inner-city mobility),
coordinated by R-Tech Regensburg (Germany), involves 10 partners including clusters, regional development
agencies, innovation accelerators and universities. The project started in February 2021 and will run for 32
months.
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